
        
            
                
            
        

    
[image: ]

Hosted for free by WindowsMode.com

[image: ]

Windows Server® 2022 & PowerShell® All-in-One For Dummies®

Published by: John Wiley & Sons, Inc., 111 River

Street, Hoboken, NJ 07030-5774, www.wiley.com

Copyright © 2022 by John Wiley & Sons, Inc., Hoboken, New Jersey

Published simultaneously in Canada

No part of this publication may be reproduced, stored in a retrieval system or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, scanning or otherwise, except as permitted under Sections 107 or 108 of the 1976 United States Copyright Act, without the prior written permission of the Publisher. Requests to the Publisher for permission should be addressed to the Permissions Department, John Wiley & Sons, Inc., 111 River Street, Hoboken, NJ 07030, (201) 748-6011, fax (201) 748-6008, or online at

http://www.wiley.com/go/permissions.

Trademarks: Wiley, For Dummies, the Dummies Man logo, Dummies.com, Making Everything Easier, and related trade dress are trademarks or registered trademarks of John Wiley & Sons, Inc. and may not be used without written permission. All other trademarks are the property of their respective owners. John Wiley & Sons, Inc. is not associated with any product or vendor mentioned in this book.

LIMIT OF LIABILITY/DISCLAIMER OF WARRANTY: WHILE THE PUBLISHER AND AUTHORS HAVE USED THEIR BEST EFFORTS IN PREPARING THIS WORK, THEY MAKE NO REPRESENTATIONS OR WARRANTIES WITH RESPECT TO THE ACCURACY OR COMPLETENESS OF THE CONTENTS OF THIS WORK AND SPECIFICALLY DISCLAIM ALL WARRANTIES, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. NO WARRANTY MAY BE CREATED OR EXTENDED BY SALES REPRESENTATIVES, WRITTEN SALES MATERIALS OR PROMOTIONAL STATEMENTS FOR THIS WORK. THE FACT THAT AN ORGANIZATION, WEBSITE, OR PRODUCT IS REFERRED TO IN THIS WORK AS A CITATION AND/OR POTENTIAL SOURCE OF FURTHER INFORMATION DOES NOT MEAN THAT THE PUBLISHER AND AUTHORS ENDORSE THE INFORMATION OR SERVICES THE ORGANIZATION, WEBSITE, OR PRODUCT MAY PROVIDE OR RECOMMENDATIONS IT MAY MAKE. THIS WORK IS SOLD WITH THE UNDERSTANDING THAT THE PUBLISHER IS NOT ENGAGED IN RENDERING PROFESSIONAL SERVICES. THE ADVICE AND STRATEGIES CONTAINED HEREIN MAY NOT BE SUITABLE FOR YOUR SITUATION. YOU SHOULD CONSULT WITH A SPECIALIST WHERE APPROPRIATE. FURTHER, READERS SHOULD BE AWARE THAT WEBSITES LISTED IN THIS WORK MAY HAVE CHANGED OR DISAPPEARED BETWEEN WHEN THIS WORK WAS WRITTEN AND WHEN IT IS READ. NEITHER THE PUBLISHER NOR AUTHORS SHALL BE LIABLE FOR ANY LOSS OF PROFIT OR ANY OTHER COMMERCIAL DAMAGES, INCLUDING BUT NOT LIMITED TO SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR OTHER DAMAGES.

For general information on our other products and services, please contact our Customer Care Department within the U.S. at 877-762-2974, outside the U.S. at 317-572-3993, or fax 317-572-4002. For technical support,

please visit www.wiley.com/techsupport.

Wiley publishes in a variety of print and electronic formats and by print-on-demand. Some material included with standard print versions of this book may not be included in e-books or in print-on-demand. If this book refers to media such as a CD or DVD that is not included in the version you purchased, you may download this

material at http://booksupport.wiley.com. For more

information about Wiley products, visit www.wiley.com.

Library of Congress Control Number: 2022930649

ISBN 978-1-119-86782-1 (pbk); ISBN 978-1-119-86784-5 (ebk); ISBN 978-1-119-86783-8 (ebk)




Windows  Server®  2022  &

 

PowerShell®  All-in-One

 

For  Dummies®

 

To  view  this  book's  Cheat  Sheet,

simply  go  to www.dummies.com  and

search  for  “Windows  Server  2022  &

PowerShell  All-in-One  For  Dummies

Cheat  Sheet”  in  the  Search  box.

 

Table  of  Contents

 

Cover

Title  Page

Copyright

Introduction

About This Book

Foolish Assumptions

Icons Used in This Book

Beyond the Book

Where to Go from Here

Book  1:  Installing  and  Setting  Up  Windows Server  2022




Chapter  1:  An  Overview  of  Windows  Server 2022

Extra! Extra! Read All About It! Seeing What’s New in

Windows Server 2022

Deciding Which Windows Server 2022 Edition Is Right for

You

Walking the Walk: Windows Server 2022 User Experiences

Seeing What Server Manager Has to Offer

Windows Admin Center: Your New Best Friend

Extending and Improving Your Datacenter




Chapter  2:  Using  Boot  Diagnostics

Accessing Boot Diagnostics

Using Advanced Boot Options

Performing a Memory Test

Using the Command Prompt

Working with Third-Party Boot Utilities




Chapter  3:  Performing  the  Basic  Installation

Making Sure You Have What It Takes

Performing a Clean Install

Upgrading Windows

Performing a Network Install with Windows Deployment

Services




Chapter  4:  Performing  Initial  Configuration Tasks

Understanding Default Settings

Getting an Overview of the Configuration Process

Providing Computer Information

Updating Windows Server 2022

Customizing Windows Server 2022

Configuring Startup Options with BCDEdit

Book  2:  Configuring  Windows  Server  2022




Chapter  1:  Configuring  Server  Roles  and Features

Using Server Manager

Understanding Server Roles

Understanding Server Features




Chapter  2:  Configuring  Server  Hardware

Working with Device Manager

Using the Add Hardware Wizard

Performing Hard-Drive-Related Tasks

Performing Printer-Related Tasks

Performing Other Configuration Tasks




Chapter  3:  Using  the  Settings  Menu

Accessing the Settings Menu

Understanding Settings Menu Items




Chapter  4:  Working  with  Workgroups

Knowing What a Workgroup Is

Knowing If a Workgroup Is Right for You

Comparing Centralized and Group Sharing

Configuring a Server for a Workgroup

Managing Workgroups

Examining the Peer Name Resolution Protocol




Chapter  5:  Promoting  Your  Server  to Domain  Controller

Understanding Domains

Preparing to Create a Domain

Performing Domain Configuration Prerequisites

Configuring the Server as a Domain Controller

Wrapping Things Up




Chapter  6:  Managing  DNS  and  DHCP  with  IP Address  Management

Installing IP Address Management

Configuring IP Address Management

Using IP Address Management

Book  3:  Administering  Windows  Server  2022




Chapter  1:  An  Overview  of  the  Tools  Menu in  Server  Manager

Accessing the Server Manager Tools Menu

Working with Common Administrative Tools

Installing and Using Remote Server Administration Tools




Chapter  2:  Setting  Group  Policy

Understanding How Group Policy Works

Starting the Group Policy Editor

Performing Computer Management

Performing User Configuration

Viewing Resultant Set of Policy




Chapter  3:  Configuring  the  Registry

Starting Registry Editor

Importing and Exporting Registry Elements

Finding Registry Elements

Understanding Registry Data Types

Understanding the Hives

Loading and Unloading Hives

Connecting to Network Registries

Setting Registry Security




Chapter  4:  Working  with  Active  Directory

Active Directory 101

Configuring Objects in Active Directory




Chapter  5:  Performing  Standard

Maintenance

Activating Windows

Configuring the User Interface

Understanding How User Access Control Affects

Maintenance Tasks

Adding and Removing Standard Applications

Measuring Reliability and Performance

Protecting the Data on Your Server

Performing Disk Management Tasks

Automating Diagnostic Tasks with Task Scheduler

Working with Remote Desktop

Working with Remote Server Administration Tools

Working with Admin Center

Creating a Windows Recovery Drive




Chapter  6:  Working  at  the  Command  Line

Opening an Administrative Command Prompt

Configuring the Command Line

Setting Environmental Variables

Getting Help at the Command Line

Understanding Command Line Symbols




Chapter  7:  Working  with  PowerShell

Opening an Administrative PowerShell Window

Configuring PowerShell

Customizing PowerShell a Little Further

Using a Profile Script

Setting Environmental Variables

Getting Help in PowerShell

Understanding PowerShell Punctuation

Book  4:  Configuring  Networking  in  Windows Server  2022




Chapter  1:  Overview  of  Windows  Server 2022  Networking

Getting Acquainted with the Network and Sharing Center

Using the Network Connections Tools

Configuring TCP/IP

Understanding DHCP

Defining DNS




Chapter  2:  Performing  Basic  Network  Tasks

Viewing Network Properties

Connecting to Another Network

Managing Network Connections




Chapter  3:  Accomplishing  Advanced Network  Tasks

Working with Remote Desktop Services

Working with Network Policy and Access Services

Troubleshooting at the Command Line




Chapter  4:  Diagnosing  and  Repairing Network  Connection  Problems

Using Windows Network Diagnostics

Repairing Individual Connections

Network Troubleshooting at the Command Line

Working with Windows Firewall

Making Sense of Common Configuration Errors

Working with Other Troubleshooting Tools

Book  5:  Managing  Security  with  Windows  Server 2022




Chapter  1:  Understanding  Windows  Server 2022  Security

Understanding Basic Windows Server Security

Working with Files and Folders

Creating a Local Security Policy

Paying Attention to Windows Security




Chapter  2:  Configuring  Shared  Resources

Comparing Share Security with File System Security

Sharing Resources

Configuring Access with Federated Rights Management

Working with Active Directory Rights Management

Services




Chapter  3:  Configuring  Operating  System Security

Understanding and Using User Account Control

Managing User Passwords

Understanding Credential Guard

Configuring Startup and Recovery Options

Hardening Your Server




Chapter  4:  Working  with  the  Internet

Firewall Basics

Configuring Windows Defender Firewall with Advanced

Security




Chapter  5:  Understanding  Digital Certificates

Certificates in Windows Server 2022

Types of Certificates in Active Directory Certificate

Services




Chapter  6:  Installing  and  Configuring  AD  CS

Introducing Certificate Authority Architecture

Installing a Certificate Authority

Configuring Certificate Auto-Enrollment




Chapter  7:  Securing  Your  DNS

Infrastructure

Understanding DNSSEC

Understanding DANE

Protecting DNS Traffic with DNS-over-HTTPS

Book  6:  Working  with  Windows  PowerShell




Chapter  1:  Introducing  PowerShell

Understanding the Basics of PowerShell

Using PowerShell

Running PowerShell Remotely

Getting Help in PowerShell

Identifying Security Issues with PowerShell




Chapter  2:  Understanding  the  .NET Framework

Introducing the Various Versions of .NET Framework

Focusing on New Features in .NET 4.8

Viewing the Global Assembly Cache

Understanding .NET Standard and .NET Core




Chapter  3:  Working  with  Scripts  and Cmdlets

Introducing Common Scripts and Cmdlets

Executing Scripts or Cmdlets

Working from Another Location

Performing Simple Administrative Tasks with PowerShell

Scripts




Chapter  4:  Creating  Your  Own  Scripts  and Advanced  Functions

Creating a PowerShell Script

Defining a Script Policy

Signing a PowerShell Script

Creating a PowerShell Advanced Function




Chapter  5:  PowerShell  Desired  State Configuration

Getting an Overview of PowerShell Desired State

Configuration

Creating a PowerShell Desired State Configuration Script

Applying the PowerShell Desired State Configuration Script

Push and Pull: Using PowerShell Desired State

Configuration at Scale

Book  7:  Installing  and  Administering  Hyper-V




Chapter  1:  What  Is  Hyper-V?

Introduction to Virtualization

Type 1 and Type 2 Hypervisors

Installing and Configuring Hyper-V




Chapter  2:  Virtual  Machines

Creating a Virtual Machine

Configuring a Virtual Machine

Shielded Virtual Machines




Chapter  3:  Virtual  Networking

Identifying the Types of Virtual Switches

Creating a Virtual Switch

Getting into Advanced Hyper-V Networking




Chapter  4:  Virtual  Storage

Understanding Virtual Disk Formats

Considering Types of Disks

Adding Storage to the Host

Adding Storage to the Virtual Machine




Chapter  5:  High  Availability  in  Hyper-V

Hyper-V Replica

Live Migration

Storage Migration

Failover Clustering

Book  8:  Installing,  Configuring,  and  Using Containers




Chapter  1:  Introduction  to  Containers  in Windows  Server  2022

Understanding Containers

Considering Use Cases for Containers

Deciding What Type of Containers You Want to Use

Managing Containers at Scale




Chapter  2:  Docker  and  Docker  Hub

Introduction to Docker

Introduction to Docker Hub




Chapter  3:  Installing  Containers  on Windows  Server  2022

Installing Windows Containers

Installing Hyper-V Containers

Installing Docker

Testing Your Container Installation




Chapter  4:  Configuring  Docker  and Containers  on  Windows  Server  2022

Working with Dockerfile

Applying Custom Metadata to Containers and Other

Objects

Configuring Containers

Configuring the Docker Daemon with daemon.json




Chapter  5:  Managing  Container  Images

Making Changes to Images and Saving the Changes You

Make

Pushing Images to Docker Hub

Pulling Images from Docker Hub

Handling Image Versioning




Chapter  6:  Container  Networking

Considering the Different Types of Network Connections

Viewing Your Network Adapters and Virtual Switches

Configuring a Network Address Translation Network

Connection

Configuring a Transparent Network Connection

Configuring an Overlay Network Connection

Configuring an l2bridge Network Connection

Configuring an l2tunnel Network Connection

Removing a Network Connection

Connecting to a Network




Chapter  7:  Container  Storage

Getting Acquainted with Container Storage

Creating a Volume Inside of a Container

Working with Persistent Volumes

Index

About  the  Author

Connect  with  Dummies

End  User  License  Agreement

 

List  of  Tables Book  1  Chapter  2

TABLE 2-1 Troubleshooting with the Command Prompt TABLE 2-2 Third-Party Boot Utilities

Book  1  Chapter  3

TABLE 3-1 Windows Server 2022 Upgrade Compatibility Matrix

Book  1  Chapter  4

TABLE 4-1 Windows Server 2022 Default Settings TABLE 4-2 BCDEdit Common Options

Book  2  Chapter  5

TABLE 5-1 Default Domain Groups

Book  3  Chapter  2

TABLE 2-1 Group Policy: Policies versus Preferences

Book  3  Chapter  6

TABLE 6-1 Command Line Symbols

Book  3  Chapter  7

TABLE 7-1 Windows PowerShell Punctuation

Book  4  Chapter  1

TABLE 1-1 DNS Record Types

Book  4  Chapter  2

TABLE 2-1 IPv4 Private Address Ranges

Book  4  Chapter  3

TABLE 3-1 Test-NetConnection Parameters

Book  4  Chapter  4

TABLE 4-1 Network Troubleshooting Tools

Book  5  Chapter  2

TABLE 2-1 Effective Permissions

Book  6  Chapter  1

TABLE 1-1 PowerShell Built-in Providers

TABLE 1-2 Common PowerShell Aliases

Book  6  Chapter  2

TABLE 2-1 .NET Versions with Release Values

Book  6  Chapter  5

TABLE 5-1 DSC Resources

Book  7  Chapter  5

TABLE 5-1 Quorum Types

Book  8  Chapter  2

TABLE 2-1 Common Docker Commands

Book  8  Chapter  4

TABLE 4-1 Docker Instructions

TABLE 4-2 Restart Policy Flags

TABLE 4-3 Allowed Configuration Options in the Windows Docker daemon.json File

 

List  of  Illustrations

 

Book  1  Chapter  1

FIGURE 1-1: Server with Desktop Experience.

FIGURE 1-2: Server Core’s sconfig utility is where you perform initial configur...

FIGURE 1-3: Server Manager is the landing page you get when you log in to Windo...

FIGURE 1-4: Managing servers with Server Manager. FIGURE 1-5: You can see all your connected devices on the All Connections page.

FIGURE 1-6: The Overview page shows, well, an overview of the device you clicke...

Book  1  Chapter  2

FIGURE 2-1: Look for the Repair Your Computer link in the lower-left corner.

FIGURE 2-2: The Advanced Options screen.

FIGURE 2-3: Your journey into the Advanced Boot Options menu starts with the Re...

FIGURE 2-4: In the Advanced Boot Options menu, you can choose what you want Win...

FIGURE 2-5: Windows Memory Diagnostics Tool options.

Book  1  Chapter  3

FIGURE 3-1: Running the Coreinfo utility on a Windows system. FIGURE 3-2: The first installation screen for Windows Server 2022. FIGURE 3-3: The Windows Server 2022 Install Now button. FIGURE 3-4: Choosing your desired edition and experience of Windows Server 2022...

FIGURE 3-5: Choose where to install Windows.

FIGURE 3-6: Choose to either keep your files and settings or start fresh.

Book  1  Chapter  4

FIGURE 4-1: The Activation screen showing that Windows Server 2022 is activated...

FIGURE 4-2: The Internet Protocol Version 4 Properties dialog box. FIGURE 4-3: Using slmgr.vbs to activate Windows Server. FIGURE 4-4: Setting the IP address with PowerShell. FIGURE 4-5: Setting the DNS servers with PowerShell. FIGURE 4-6: Using the Local Group Policy Editor to change the automatic updates...

FIGURE 4-7: Setting automatic updates in PowerShell. FIGURE 4-8: The select Server Roles Screen with File Server selected.

FIGURE 4-9: Allowing an app through Microsoft Defender Firewall. FIGURE 4-10: Using PowerShell to install roles and features. FIGURE 4-11: Using Get-NetFirewallRule to find rules. FIGURE 4-12: Using PowerShell to set firewall rules and validate that they’re e...

FIGURE 4-13: Using bcdedit  /enum to see the current settings of the boot config...

FIGURE 4-14: Using bcdedit  /set to alter the description of the Windows Boot Lo...

Book  2  Chapter  1

FIGURE 1-1: The Server Manager Dashboard with the Quick Start tile at the top.

FIGURE 1-2: The File and Storage Services management window.

FIGURE 1-3: The Tools menu in Server Manager.

FIGURE 1-4: The Server Manager’s Local Server properties screen. FIGURE 1-5: Working with disks in the File and Storage Services area of Server ...

Book  2  Chapter  2

FIGURE 2-1: Device Manager on Windows Server 2022 will look familiar to those w...

FIGURE 2-2: Customizing your Device Manager view. FIGURE 2-3: Device Manager makes it simple to identify devices with problems.

FIGURE 2-4: The General tab for a VirtualBox CD-ROM drive. FIGURE 2-5: You have two options when updating drivers in Windows Server 2022 t...

FIGURE 2-6: The Add Hardware Wizard.

FIGURE 2-7: Installing the MPIO feature in Windows Server 2022. FIGURE 2-8: Select the Multipath I/O check box on the Select Features screen.

FIGURE 2-9: The Storage Pools screen showing available physical disks.

FIGURE 2-10: Choose a name for your storage pool and choose the primordial pool...

FIGURE 2-11: Configuration of the physical disks in the storage pool.

FIGURE 2-12: You have to name your virtual disk before you can use it.

FIGURE 2-13: Selecting the storage layout can be very important if you need it ...

FIGURE 2-14: Creating a volume that the operating system can use is simple afte...

FIGURE 2-15: Choosing a drive letter for my new volume. FIGURE 2-16: Adding features that are needed for BitLocker Drive Encryption to ...

FIGURE 2-17: Getting to the BitLocker Management screen from the Control Panel.

FIGURE 2-18: Turning on BitLocker for Volume1.

FIGURE 2-19: Setting a password for BitLocker To Go.

FIGURE 2-20: Configuring BitLocker to work without a TPM module involves editin...

FIGURE 2-21: Enabling software-based encryption for BitLocker. FIGURE 2-22: Allowing alternate authentication methods for the system drive.

FIGURE 2-23: Letting the operating system drive encrypt or decrypt without a TP...

FIGURE 2-24: Selecting how you’ll find your printer. FIGURE 2-25: Configuring the IP address of your printer. FIGURE 2-26: Advanced Options gives you more settings to work with.

FIGURE 2-27: The Printer Properties screen allows you to change configuration i...

FIGURE 2-28: Install the Print and Document Services role to set up your print ...

FIGURE 2-29: Select Print Server for the role that you want to install.

FIGURE 2-30: Adding a printer to the Print Server. FIGURE 2-31: Naming the printer and adding a location makes it easier for your ...

FIGURE 2-32: You can adjust the keyboard settings to work better with your typi...

FIGURE 2-33: You can adjust the mouse settings to customize your experience.

FIGURE 2-34: Advanced Power Settings lets you create a granular power managemen...

FIGURE 2-35: The Language screen allows you to adjust settings for language and...

FIGURE 2-36: Samples of the installed fonts available on the server.

Book  2  Chapter  3

FIGURE 3-1: The Settings menu in all its glory.

FIGURE 3-2: The System menu contains a lot of configuration choices.

FIGURE 3-3: The Devices menu allows you to install and configure peripherals.

FIGURE 3-4: The Network & Internet menu provides options to configure server ne...

FIGURE 3-5: The Personalization menu gives you many options to make your server...

FIGURE 3-6: The Apps menu allows you to work with installed applications.

FIGURE 3-7: The Accounts menu allows you to set up various methods of authentic...

FIGURE 3-8: The Time & Language menu lets you determine how date and time shoul...

FIGURE 3-9: The Ease of Access menu allows you to configure accessibility optio...

FIGURE 3-10: The Privacy menu allows you to configure tracking and advertisemen...

FIGURE 3-11: The Update & Security menu is where you can manage the security-re...

Book  2  Chapter  4

FIGURE 4-1: Configuring the workgroup begins in the Local Server screen in Serv...

FIGURE 4-2: The System Properties dialog box allows you to set the workgroup na...

FIGURE 4-3: Setting the workgroup name.

FIGURE 4-4: Creating a group to allow access to workstation resources.

FIGURE 4-5: Creating a user account to allow access to workstation resources.

FIGURE 4-6: Selecting the group for your user account. FIGURE 4-7: Selecting the folder you want to share in the Create a Shared Folde...

FIGURE 4-8: Customizing the shared folder permissions. FIGURE 4-9: The new folder share is visible in the Shares section of Shared Fol...

FIGURE 4-10: The Advanced Sharing dialog box allows you to configure the share.

FIGURE 4-11: Clicking Other Users allows you to manage accounts other than your...

FIGURE 4-12: Managing the account of another user. FIGURE 4-13: PowerShell window with user account management code line.

Book  2  Chapter  5

FIGURE 5-1: The DNS Manager screen after installation with no zones configured.

FIGURE 5-2: Naming your zone indicates which zone the DNS server is authoritati...

FIGURE 5-3: Assigning the Network ID.

FIGURE 5-4: DHCP Console allows you to configure DHCP services. FIGURE 5-5: The IP Address Range screen allows you to specify the address range...

FIGURE 5-6: Setting the domain name and DNS servers in the DHCP Scope Options.

FIGURE 5-7: Promoting the server to a domain controller. FIGURE 5-8: Checking the prerequisite checks passed before installing.

FIGURE 5-9: Setting the properties of your DNS zone to AD integrated.

FIGURE 5-10: Using nslookup to verify that DNS is working properly.

FIGURE 5-11: Creating a new user in Active Directory. FIGURE 5-12: Creating my first user, John Smith.

FIGURE 5-13: Sharing a folder to a domain security group. FIGURE 5-14: The System Properties box allows you to change the computer name a...

FIGURE 5-15: Changing the domain membership of the server. FIGURE 5-16: The sconfig menu in Server Core is the main system configuration a...

FIGURE 5-17: Active Directory–integrated DNS zones offer improved replication a...

FIGURE 5-18: DHCP address leases for all your domain-joined systems.

Book  2  Chapter  6

FIGURE 6-1: IPAM shows up in Server Manager after it’s installed. FIGURE 6-2: Provisioning methods for IPAM include manual or Group Policy based.

FIGURE 6-3: Configuring server discovery in IPAM. FIGURE 6-4: Setting the manageability status of the server to Managed.

FIGURE 6-5: Some of the actions you can take against servers that are being man...

FIGURE 6-6: The Server Inventory screen gives you a list of your servers and wh...

FIGURE 6-7: IP address utilization is easy to see at a glance in IPAM.

FIGURE 6-8: The status of the DNS and DHCP servers that are being monitored and...

FIGURE 6-9: DHCP Scope configuration can be done across multiple DHCP servers a...

FIGURE 6-10: Configuring DNS zones can be done from inside of IPAM.

FIGURE 6-11: Creating a DNS Zone Administrator is easy given the granular permi...

FIGURE 6-12: The new role is created and shows up with the built-in roles.

Book  3  Chapter  1

FIGURE 1-1: The Tools menu from within Server Manager. FIGURE 1-2: Windows Administrative Tools in the Start Menu is the same as the T...

FIGURE 1-3: Accessing the Tools menu through Control Panel. FIGURE 1-4: The Computer Management console gives you a centralized area to use...

FIGURE 1-5: Defragmenting you hard drive is a scheduled task, but you can choos...

FIGURE 1-6: The Disk Cleanup utility in all its glory. FIGURE 1-7: Using a filter in Event Viewer to find failed logins. FIGURE 1-8: The local password policy set in Local Security Policy. FIGURE 1-9: System colors are stored in the Registry. FIGURE 1-10: The Server service Properties page allows you to set startup type ...

FIGURE 1-11: The General tab in System Configuration lets you set the type of s...

FIGURE 1-12: Creating a custom task in Task Scheduler. FIGURE 1-13: Searching Active Directory for systems to manage. FIGURE 1-14: Server Manager showing the roles from the system I added.

FIGURE 1-15: Managing a remote server with Server Manager on Windows 10.

Book  3  Chapter  2

FIGURE 2-1: The Default Domain Policy is set at the domain level. FIGURE 2-2: Creating a new GPO.

FIGURE 2-3: Setting up software to be deployed via Group Policy. FIGURE 2-4: Setting the audit policy to track both successes and failures.

FIGURE 2-5: Software deployed via the User Configuration. FIGURE 2-6: Setting up folder redirection for the Documents folder.

FIGURE 2-7: RSoP shows which GPOs are successfully applied.

Book  3  Chapter  3

FIGURE 3-1: The Registry Editor allows you to work with the hives and keys in t...

FIGURE 3-2: Searching the Registry for a specific key. FIGURE 3-3: Data types in the Registry with sample values. FIGURE 3-4: HKCR keeps tracks of associations between file types and programs.

FIGURE 3-5: HKCU contains pointers to the currently logged on user's settings.

FIGURE 3-6: SIDs for each account on the system are stored in HKU.

FIGURE 3-7: Loading a hive allows you to compare settings including user settin...

FIGURE 3-8: Remote Registry is useful for comparing or making quick changes to ...

FIGURE 3-9: Setting permissions on the Windows Registry is very similar to sett...

FIGURE 3-10: Disabling the Remote Registry service ensures that nobody can conn...

FIGURE 3-11: Restricting remote administration to specific subnets is a great l...

Book  3  Chapter  4

FIGURE 4-1: Setting the trust name for the new trust. FIGURE 4-2: Setting the type of trust.

FIGURE 4-3: Setting the direction of the trust.

FIGURE 4-4: Setting where you want to set the trust at. FIGURE 4-5: The successful completion of the New Trust Wizard. FIGURE 4-6: Creating a site in Active Directory.

FIGURE 4-7: Configuring a subnet for the new Active Directory site.

FIGURE 4-8: Creating a new user from within Active Directory Users & Groups.

FIGURE 4-9: The Properties screen for the user account gives you more options t...

FIGURE 4-10: Creating a new group in Active Directory Users & Groups.

FIGURE 4-11: Enable the Active Directory Recycle Bin through the Active Directo...

FIGURE 4-12: Creating a user in Active Directory Administrative Center gives yo...

Book  3  Chapter  5

FIGURE 5-1: The activation window showing that Windows Server 2022 is activated...

FIGURE 5-2: Using slmgr.vbs to activate Windows Server. FIGURE 5-3: You can access the Folder Options dialog box through the View tab i...

FIGURE 5-4: The General tab of the Folder Options dialog box. FIGURE 5-5: The View tab of the Folder Options dialog box. FIGURE 5-6: The Search tab of the Folder Options dialog box. FIGURE 5-7: The Internet Properties dialog box.

FIGURE 5-8: Viewing the available font faces for the Courier New font.

FIGURE 5-9: The troubleshooting utility can notify you of issues and possible r...

FIGURE 5-10: The Performance Options dialog box. FIGURE 5-11: The User Account Control Settings dialog box. FIGURE 5-12: Uninstalling a program in the Apps & Features section of the Setti...

FIGURE 5-13: Performance Monitor running on Windows Server 2022.

FIGURE 5-14: Troubleshooting resource contention is simple with Resource Monito...

FIGURE 5-15: Task Manager in Windows Server 2022. FIGURE 5-16: Windows Server Backup allows you to create and run backups, once o...

FIGURE 5-17: Restoring some files through Windows Server Backup.

FIGURE 5-18: Managing a disk volume in File and Storage Services.

FIGURE 5-19: Disk defragmentation runs automatically once a week, but it can st...

FIGURE 5-20: Task Scheduler is the central area for managing automated/schedule...

FIGURE 5-21: Configuring one of the Windows Server preconfigured tasks.

FIGURE 5-22: Changing a preconfigured task to run every day. FIGURE 5-23: Connecting to another system via a Remote Desktop Connection.

FIGURE 5-24: Using RSAT to manage remote servers from a Windows 10 client.

FIGURE 5-25: There are lots of options to manage a remote server using RSAT.

FIGURE 5-26: Connecting to a server with Windows Admin Center. FIGURE 5-27: The Server Manager view in Windows Admin Center.

Book  3  Chapter  6

FIGURE 6-1: Running the Command Prompt as administrator allows you to run more ...

FIGURE 6-2: The Options tab allows you to customize how you interact with the C...

FIGURE 6-3: The Font tab allows you to change the font and how it displays in t...

FIGURE 6-4: The Layout tab configures what the window looks like.

FIGURE 6-5: The Colors tab lets you customize colors in the Command Prompt.

FIGURE 6-6: Further customizations that are available in the Command Prompt.

FIGURE 6-7: Displaying environmental variables and their current settings is po...

FIGURE 6-8: The view after appending a folder to my PATH environment variable.

FIGURE 6-9: Using the Command Prompt help to get more information on a command.

FIGURE 6-10: Using the help command in the Command Prompt.
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FIGURE 7-1: Windows PowerShell now resides by default in the menu that you acce...

FIGURE 7-2: The Options tab allows you to customize how you interact with Windo...

FIGURE 7-3: The Font tab allows you to change the font and how it displays in P...

FIGURE 7-4: The Layout tab configures what the PowerShell window will look like...

FIGURE 7-5: The Colors tab allows you to customize screen colors in Windows Pow...

FIGURE 7-6: Further customizations that are available in the Command Prompt.

FIGURE 7-7: Displaying environmental variables and their current settings is ea...

FIGURE 7-8: The view after creating a new environment variable. FIGURE 7-9: Using the PowerShell Help to get more information on the Get-Comman...

FIGURE 7-10: Using the help command in Windows PowerShell.
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FIGURE 1-1: The Network and Sharing Center in Windows Server 2022.

FIGURE 1-2: Getting to the network adapter properties screen. FIGURE 1-3: Troubleshooting your Internet connection with the built-in troubles...

FIGURE 1-4: The Status screen in the Network & Internet section of Settings.

FIGURE 1-5: The Ethernet screen in the Network & Internet section of Settings.

FIGURE 1-6: The Firewall & Network Protection screen in the Network & Internet ...

FIGURE 1-7: The VPN screen in the Network & Internet section of Settings.

FIGURE 1-8: The Proxy screen in the Network & Internet section of Settings.

FIGURE 1-9: Selecting which network protocol you want to work with in the adapt...

FIGURE 1-10: Statically set IP and DNS server settings are common on servers se...

FIGURE 1-11: The Advanced TCP/IP Settings dialog box lets you perform more adva...

FIGURE 1-12: Selecting the replication scope for the new zone is important; in ...

FIGURE 1-13: The legal.sometestorg.com zone provides a separate administrative ...
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FIGURE 2-1: Working with the properties of a network adapter. FIGURE 2-2: The Properties dialog box for the network adapter allows you to cha...

FIGURE 2-3: Setting up a proxy script for Internet access on a Windows server.

FIGURE 2-4: Configuring a dial-up connection in Windows Server 2022 is simple i...

FIGURE 2-5: Setting up a VPN for remote access with the built-in Windows VPN cl...

FIGURE 2-6: IPv4 properties are set through the network adapter Properties dial...

FIGURE 2-7: IPv6 properties are set through the network adapter Properties dial...

FIGURE 2-8: It’s simple to install clients, services, and protocols like the Re...
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FIGURE 3-1: Selecting Remote Desktop Services is a departure from the usual ste...

FIGURE 3-2: Installing the RDS role on a single server via the Quick Start inst...

FIGURE 3-3: Setting up a user’s profile to take full advantage of the RDS funct...

FIGURE 3-4: Adding a non-Windows program to the list of RemoteApp programs avai...

FIGURE 3-5: The logon screen for RD Web Access is simple and elegant.

FIGURE 3-6: When you select an application in the RD Web Access console, a remo...

FIGURE 3-7: Click the plus sign to install the RD Licensing role. FIGURE 3-8: The Settings tab is where the bulk of the configuration happens for...

FIGURE 3-9: A network policy allowing traffic needs to have the lower processin...

FIGURE 3-10: You can test basic connectivity with just a few parameters added t...
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FIGURE 4-1: The Windows Network Diagnostics screen is a wizard that helps you d...

FIGURE 4-2: The Additional Troubleshooters link contains many troubleshooting t...

FIGURE 4-3: Windows Network Diagnostics can diagnose many issues, including dis...

FIGURE 4-4: The ping utility gives you a simple readout and can point out an is...

FIGURE 4-5: Event Viewer can show you when Windows Firewall has blocked an inco...
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FIGURE 1-1: The CIA triad is one of the most basic concepts in information secu...

FIGURE 1-2: Discretionary access control lists can be used to determine who sho...

FIGURE 1-3: Using an SACL to audit privileged access to a folder is simple.

FIGURE 1-4: You can use Group Policy to set your SACLs so that you can apply th...

FIGURE 1-5: You can set permissions very granularly with the Security tab in th...

FIGURE 1-6: Share permissions allow you to grant Full Control, Change, or Read ...

FIGURE 1-7: Checking the effective permissions of a user account is a great way...

FIGURE 1-8: The Local Security Policy screen allows you to set local security s...

FIGURE 1-9: The Virus & Threat Protection dashboard offers a full-featured anti...

FIGURE 1-10: Changing the firewall settings from Firewall & Network Protection ...

FIGURE 1-11: App & Browser Control gives you the ability to protect yourself ag...

FIGURE 1-12: Exploit Protection provides several more advanced mechanisms to pr...

FIGURE 1-13: The Hypervisor Control Integrity feature is shown under Core Isola...
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FIGURE 2-1: Share permissions are pretty open in this example. Everyone has ful...

FIGURE 2-2: Here, NTFS permissions set on the Security tab are more restrictive...

FIGURE 2-3: The Effective Access tab shows you what a user or group actually ha...

FIGURE 2-4: Sharing a storage device follows similar steps to sharing a folder.

FIGURE 2-5: Configuring the AD FS role after installation. FIGURE 2-6: Review your AD FS settings before completing the configuration.

FIGURE 2-7: After AD RMS is installed, you need to configure it. FIGURE 2-8: You can manage AD RMS from the console available through Server Man...

FIGURE 2-9: Creating the Rights Policy Template defines what you want to apply ...

FIGURE 2-10: Ensuring that a user can view but do nothing else is simple with A...

FIGURE 2-11: Creating the folders and the shares is simple through Windows Powe...

FIGURE 2-12: When the share is created, you need to point AD RMS to where you w...
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